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1 HomeVoice™ User Guide 

1.1 Overview 
 
Successful operation of HomeVoice™ with the rest of your home automation (HA) equipment is 
dependent upon correctly accomplishing the following: 
 

•  Setting up users. 
•  Defining/editing voice command phrase(s). 
•  Identifying the (optional) voice response phrase(s) or sound file(s). 
•  Training the voice command phrase to increase recognition success and command 

execution reliability. 
•  Sampling background noise. 

 
In the normal operating mode, HomeVoice™ will run in sleep mode listening for one of the user’s 
wakeup commands against the general level of background noise.  Once a wakeup command is 
recognized, the software makes the specific user’s list of voice commands active.  These lists of 
commands are referred to as grammars. Each user should have a minimum of two grammars, a 
wakeup list and an active command list.  The wakeup grammar should only contain phrases 
designed to access the user’s active command list or commands that switch to another user’s 
command lists. In general it is not recommended to place automation commands in the wakeup 
grammar as you could likely experience these commands being executed during normal 
conversation. Wakeup Command Syntax discusses wakeup commands, Changing Users via 
Voice Command discusses how to switch from one user to another user using voice command. 
Refer to the Listen Users Guide for more complete information regarding grammars. 
 
You may issue multiple voice commands while HomeVoice™ is awake.  However, you must wait 
for the optional response to play before issuing any additional commands. After a short period of 
time when HomeVoice™ doesn’t hear any recognized commands, the software will timeout and 
return to sleep mode.  This timeout value is a parameter that can be changed to suit the user in 
User Preferences. 
 
The initial voice recognition capability for HomeVoice™ voice commands is generally speaker 
independent.  However, to obtain a high level of successful voice recognition and command 
execution, it is highly recommended that you train your voice commands.  It takes only a few 
minutes to train a long list of commands.  Training will allow HomeVoice™ to “learn” your voice 
and increase the ability for HomeVoice™ to properly identify your commands against a noisy 
background. 
 
HomeVoice™ samples the background noise to establish a baseline level against which it listens 
for your voice commands.  The software will take a noise sample when it is started and will 
prompt you to sample noise when training commands.  Sampling noise can even be issued as a 
voice command and it is recommended that you issue the Sample Noise command whenever 
your home’s noise level changes significantly.  Sample Noise is one of the example commands 
that are provided with HomeVoice™ installation. Note: DO NOT DELETE THIS COMMAND. 
 
The following sub-sections discuss how to accomplish user activities with the HomeVoice™ 
software.    
 

1.2 Initial HomeVoice™ Start-up  
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After installing the software you can start HomeVoice™ from the Windows Start button, selecting 
Programs, selecting HomeVoice, and selecting HomeVoice 2.3.   
 
You will be prompted to set up the initial user of the system. Enter a name and click OK.  
 

 
 
 
 

 
 
When prompted, click Yes to sample the noise environment. The sample noise option will allow 
HomeVoice™ to measure background noise to allow for operation in a noisy environment.  The 
software will measure the relative ambient background noise and then listen for identified 
commands against that background. This completes the user setup section.  
 
To add additional users refer to Adding New Users. 

1.3 Normal HomeVoice™ Start-up 
 
You start HomeVoice™ from the Windows Start button, selecting Programs, selecting 
HomeVoice™, and selecting HomeVoice™ 2.3.   
 
The HomeVoice™ window will appear with a blinking cursor in the window while the Listen 
engine starts. Once the Verbex Listen window is completely up, HomeVoice™ is now ready to 
accept voice commands and allow you to edit your commands and responses. 
 
Please note that the HomeVoice™ and Verbex Listen windows must be active but can be 
minimized to the task bar for HomeVoice™ to operate correctly. 
 

Do not change the sub directory 
field as it is directly related to 
your user ID. Both the response 
and the Listen™ library files 
reference this Sub directory. For 
proper operation, we recommend 
this field remain unchanged. 

When prompted, select your voice 
gender. In general males under 14 should 
select female. Adult males have deeper 
base tones than females while the female 
voice is softer and not as deep. Use of 
this selection is correct for a young 
male’s voice recognition since their voice 
has not developed yet and is still 
considered to be soft. Click on OK and 
continue. 
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Note: If adding HomeVoice™ to the system startup menu, so that HomeVoice™ is started when 
the system is started, if there are other software packages that are also started, the Verbex Listen 
may not synchronize properly and you will receive an error (vassl –198). Restart HomeVoice™ 
after the system is up and everything should function properly. 
 

1.4 Sampling Noise 
 
As previously mentioned, sampling background noise is a commonly used command.  It can be 
used at start-up, during command training sessions and at anytime a user wishes to reset the 
background noise level.  This feature can be disabled in User Preferences, but noise sampling 
will only increase the voice recognition success. This feature is particularly helpful in high noise 
environments.  With appropriate noise sampling and voice command training, the voice 
recognition can be extremely accurate in high noise environments.  

1.5 Training Voice Commands 
 
For better voice recognition, you must train the voice commands.  From the “Verbex Listen” 
window highlight the specific commands you wish to train. 

 
 
 
 

 
 
This will start the training process and the ambient noise will be sampled again. 
 

To train all the voice commands, choose Select All from the Edit menu. 
This selection will train your entire voice grammar including number 
training. This should be done initially after all phrases have been added or 
edited. In order to train all phrases over again all the phrases must be 
highlighted and selected for training.  

To train a single phrase, highlight the phrase, choose Train Selected from 
the Train menu.  
 
This process can also be used to train several phrases at once. Simply 
highlight the phrases that need to be trained (while holding down the 
control key) and then choose the Train Selected under the Train menu.  
This will only work in the current user’s active window in which the 
phrases exist. If you want to train your active commands but your wake up 
commands are listed, then wake the system up and highlight the 
commands that you wish to train. 
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The training should be done in the normal environment where the system will be used. Follow the 
instructions provided in the training window.  After training the command, you may Continue to 
train additional voice inflections (recommended 2-3 times) or Exit Training to finish. Once you 
have finished command training, the system will need to rebuild the  voice file.  This may take a 
few moments depending on processor speeds. Once this rebuild process is complete, 
HomeVoice™ is ready for use again and will recognize your voice commands.  
 
Note: When training commands only one voice should be present. Train with normal background 
noise, but do not train while other voices may be picked up on the microphone. When using multi-
microphone systems, initial training should be performed with the microphones in other rooms 
turned off. 
 
For example, it is difficult to train commands while two other people may be having a 
conversation which the microphone is picking up. Therefore if the two people are in a different 
room the microphone for that area should be disabled during initial training. 
 

1.6 How to Add a New Command 
 
 

1.6.1 General Command Overview 
For Windows 95 and 98 only! 
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To add a command, select Add New Phrase under the Edit menu in the “Verbex Listen” window.  
This option will not be available if a command is highlighted; if you have a command highlighted, 
wait a few seconds for the timeout to put HomeVoice™ in sleep mode and then wake it up 
without highlighting a command and select Add New Phrase.  
 

 
In the dialog provided (shown below), enter the spoken phrase you want. Use only lower case 
when entering the voice command in the Spoken Phrase area.  The “Verbex Listen” voice 
recognition engine, unlike HomeVoice™ in general, is case sensitive and prefers to have lower 
case commands. 
  

 
For all operating systems: 
 
Creating or editing commands can also be 
accomplished through the Listen Command 
Editor (LCE). This method is recommended if 
you are adding, editing, or deleting more 
than one or two commands. See Page 26 for 
more information. 
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You have a choice of two methods for entering automation commands.  In the keystrokes box, 
you can enter an X-10, Infrared or ASCII controller command text string or series of commands 
strings.  Or by using the buttons on the right hand side of the dialog box, you may use a point and 
click selection method to build the proper command syntax for X-10, Infrared or ASCII.  For 
Infrared, the point and click selection method will give you the ability to select from the list of 
Infrared commands contained in your Infrared database.  You can also use the point and click 
method to enter a series of command strings that can be executed with one voice command. 
 

 
The limit to creating a series of command strings is ten total X10, Infrared, and/or ASCII 
commands, or 128 characters total.  With the use of a home controller with macro capabilities, 
names can be assigned to a macro and then an ASCII command using that named macro could 
be directed to the home controller. This is helpful if more than ten controller commands need to 
be issued with one voice command. 
 
In addition to the controller command, you can also put in the optional responses for this voice 
command. Use the RESPONSES button for access to this capability. Section Responses 
discusses response creation in more detail. 
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Regardless of the method used to create commands, when you have finished, click Save.  The 
system will then rebuild the voice files to add the new command.  A window will appear that 
shows the progress of the rebuild process.  
 

 
Note: There are certain characters, which may cause an error, which will cause the rebuild to fail. 
If this happens, there is a good copy of the users’ grammar file, which is saved prior to making 
changes. This file is in the users’ directory (e.g. C:\homevoic\lfw40\tom). The file is named 
“homevo.bak”, by copying this file and replacing “homevo.grm”. The change causing the error is 
removed. Any changes made during the last edit session are also lost. 

1.6.2 X-10 Commands 
 
This section will discuss building an X-10 command.  As mentioned, you may manually enter the 
command or commands in the keystrokes box or you may use a point and click selection method 
to build proper command syntax.  Regardless of the method, the following X-10 command set is 
used with HomeVoice™ and is shown in the key stoke field when building command strings: 
 

House code A-P 
Device code  1-16 
Action codes OFF, ON, DIM, BRT (bright), ALON (all lights on), ALOFF (all lights 

off), AUOFF (all units off) 
Repetitions 1-25 

 
To use the point and click method, click on the X-10 button in the New Phrase window (see How 
to Add a New Command).  The following dialog box will appear: 
 

 
 

 

When this rebuild is complete, 
HomeVoice™ is ready for use. 

 
While creating a command 
with this method, any 
previously entered 
command strings will be 
displayed in the current 
command window.   This 
comes in handy when 
building a voice command 
with multiple automation 
command strings. 
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To build a command string, click on the desired house code, device code and command as 
appropriate.  To turn a unit on or off select the house and unit code and the appropriate 
command.  To dim or brighten a light, select the house and unit code, choose dim or bright and 
enter the level in the small box that appears when you chose dim or bright.  The all lights on 
(ALON), all lights off (ALOFF) and all units off (AUOFF) must include a house code.  Click Add to 
add the new command string, click done when you are finished adding X-10 command strings.  
You may use the IR or ASCII button to add additional command strings of those types (discussed 
in the next sub-sections). 
 
 
The general syntax for a X-10 command is: 
 
"X10=(house code)(device number)<space>(action)=(repetitions)" 
 
The following example shows the keystroke command syntax that will turn unit A5 on and unit A4 
off. 
 

 
 
The tilde ‘~’ key is the required delimiter between the commands.  If you use the point and click 
method for building commands, HomeVoice™ will automatically place this delimiter between the 
commands.  If you are entering the command string manually, you must add this delimiter. 
 
“X10=A5 on~x10=a4 off” 
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Note: It is better to place commands with repetitions at the end of a multiple command string. The 
following example command shows how to issue your equipment the X10 House Code "A" 
Device # "1" and Dim the light 3 levels  

 
 
 
(One DIM command plus 3 repeats): 
 
"X10=A1 DIM=3" 
 
Remember to click SAVE to save and rebuild your new voice command when finished. 
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1.6.3 Infrared Commands 
 
This section will discuss building an Infrared command for your new voice command, i.e., “spoken 
phrase”.  As mentioned, you may manually enter the command or commands in the keystrokes 
box or you may use a point and click selection method to build proper command syntax.  The 
Infrared commands that are used in either method must be consistent with your Infrared 
database. If you use the point and click method to build the command string, you will be choosing 
from a list of commands that are in your Infrared database, or are understood by your Infrared 
controller.  Infrared command sets and databases are discussed in further detail in later sections. 
For the purpose of this section, we assume that a database is available.   

 
To enter an Infrared command manually, type the command string in the Keystrokes area (note: 
HomeVoice™ is not upper/lower case sensitive).  The following example would issue the amp 
tuner selection mode assuming you have this function mode with your equipment and it is trained 
in your database as "amp tuner". 

 
"irr=Amp tuner” 
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To use the point and click method, click on the IR Command button in the New Phrase window.  
The following dialog box will appear: 
 

 
 
Click ADD to add the new command string. Click DONE when you are finished adding Infrared 
command strings.  You may use the X-10 or ASCII button to add additional command strings of 
those types (discussed in the other sub-sections).  Click SAVE to save and rebuild your new 
voice command when finished. 

 
For example: 
 
Irr=tv 12 
irr=dss 579 
irr=vcr 07 

 
This type of command syntax could be used for a favorite channel option, so if you wanted to 
watch HBO1 the spoken phrase could be “lets watch some HBO” and the actual command would 
be “irr=dss 110”. 
 
Another way to issue the same command would be to use a list command: 
 

Irr=tv {tvlist} 
irr=dss {dsslist} 
irr=vcr {vcrlist} 

 
List commands are used to abbreviate sequential strings of commands, If your DSS receiver has 
500 channels you could create a list with numbers 1 to 500. This way 500 channel commands do 
not have to be entered in the users’ commands, only one command with a reference to 500 
numbers is used.  To learn more on List commands refer to Using LISTS in HomeVoice™ or the 
Listen Users Guide. 
 
For Infrared controllers which have more than one IR transmission zone or outputs, the irr will tell 
the controller to transmit the signal on all output ports. For individual port combinations refer to 
documentation on the specific IR controller in the appendix. 
 

You don’t have to remember what you 
named the Infrared command when 
setting up the Infrared database. The 
IR Command button will not only 
show the existing command but will 
access your Infrared database to 
show what Infrared descriptions are 
associated with your Infrared buttons.  
If you are using Infrared zones, you 
can also make that identification here 
in building the IR command. 
(Available for JDS and AFT 
Controllers only) 



Copyright 2002 Applied Future Technologies, Inc. 1-14

1.6.4 ASCII Commands 
 
To accommodate controllers with an ASCII command capability, HomeVoice™ has an ASCII 
command capability.  To enter ASCII commands, click the ASCII button and enter the ASCII 
command string you desire.  This string should be in the format defined by your controller 
manufacturer.   
 
The format for the ASCII command is: 
 
 asc=<ASCII Command String> 
 
HomeVoice™ will send all characters following the equal sign (=) out the serial port specified in 
the Homevoic.ini file. 
 
Below is an example of a HomeVision ASCII command: 
 
asc=test macro 
 
In this command HomeVoice™ will send the string “test macro”, without quotes, to the controller’s 
serial port. The controller may then key on this string to perform whatever action is specified. 
 
If characters such as carriage returns, enter, backslash, etc., need to be sent to the controller in 
ASCII commands, check the keystroke expansion box on the edit phrase dialog. Then type the 
“Enter” key, <ENTER> will be placed in the command string. This tells HomeVoice™ to send the 
enter character. 
 
With HomeVoice™ 2.3 there is support for three different controllers. In order to send ASCII 
commands to a controller other than the default the command ASC, ASC1, ASC2 and ASC3 are 
provided. ASC1 is the same as ASC and will send the ASCII string to the default controller. ASC2 
will send the ASCII string to the X10 Controller and ASC3 will send the string to the IR Controller. 
 

1.6.5 Hexadecimal Command 
 
The ASCII command is used for standard keyboard type-able characters. Depending on the 
controller you are sending the command to it may be desirable to send ASCII characters which 
are not found on the keyboard. To send these characters the “Hex” command is used. The format 
of this command is: 
 

Hex = 0f 13 67 49 67  
 

This command will send the 5 characters corresponding to the hexadecimal values out the serial 
port. The spaces between the numbers are for readability, no spaces are sent unless the value 
for the space character is specified. 
 
 

1.6.6 Pause Command 
 
 
  The pause command is for adjusting timing between HomeVoice™ and the controller. When a 
controller acknowledges receipt of a command HomeVoice™ will send the next command if there 
is one in the queue. In some situations the controller and HomeVoice™ send the signals faster 
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than the equipment can handle. In these cases the "Pause" command is used. The syntax of the 
command is: 
 
  Pause=time  where time is specified in milliseconds 
 
So to introduce a quarter second pause between two commands the keystrokes would be: 
 
Irr=Amp power~pause=250~irr=amp tuner 
 
In this example a 250-millisecond pause is placed between the transmission of the amp power 
signal and the amp tuner signal. 
 
The pause command can be quite helpful for short duration, 10 seconds or less, timing issues. 
DO NOT use the pause command for long duration pauses, as it will interfere with HomeVoice™ 
command processing. 
 

1.6.7 Responses 
 
HomeVoice™ will play user-defined phrases, sound files (.wav) or text files (.txt) in response to 
the voice command being issued.  HomeVoice™ allows for up to 10 responses for a given 
Spoken Phrase. When the spoken phrase is issued HomeVoice™ will select one of the 
responses specified at random. HomeVoice™ uses a 32-bit speech synthesizer to convert user-
defined text input to speech output. HomeVoice™ will issue voice responses to commands if the 
responses are set up in the ‘Responses:’ field. Responses are specified in the Edit Phrase dialog 
window. 
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The ability to play wave files as well as voice responses (i.e., text to speech synthesis) is unique 
to HomeVoice™. This example shows how a combination of text to speech and wave files can be 
played.  
 
HomeVoice™ allows for a total of 255 characters, for the total of all responses, in the response 
field. In general, responses to commands should be short, as voice commanding is unavailable 
while sound output is active. Responses are primarily for acknowledgment of command receipt by 
the controller. Longer responses will slow the ability to issue additional voice commands. For 
longer synthesized text responses a text file (.TXT) may be specified.  
 
By clicking the REPONSES button you will receive the following dialog. You may enter or edit all 
ten responses for a command at one time using this dialog. 
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You may also enter and edit responses one at a time by clicking on the radio button for the 
response. By clicking on the radio button you will see the following dialog. 
 
 
 
 
 
 
 
 

The response field can have up to ten 
different responses to the same 
command. The length of the wave file 
or the size of the text to speech 
response may cause the system to 
respond more slowly. Keep this in 
mind when adding responses. If you 
have one command with a long 
response and wonder why the system 
takes longer to receive the next 
command, try to shorten your 
responses.  
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1.6.7.1 How HomeVoice™ determines the response. 
 
HomeVoice™ uses a two-tier algorithm to find responses when a command is issued. By proper 
application of this algorithm, a command may issue one or more responses. 
 
HomeVoice™ searches first for a response for the spoken phrase issued. If it does not find a 
response for the spoken phrase it will then search for a response for the command issued. This 
allows for a spoken phrase with multiple commands attached to provide just one response or 
possibly a response for each command. 
 
Example: (Multiple command phrase with one response) 
 
 Spoken Phrase: theater mode 
 Keystroke: “IRR=AMP POWER~IRR=VCR POWER~X10=A5 OFF~IRR=VCR PLAY” 
 Responses: Movie time! 
 

In this example every time the command “theater mode” is issued the   response will be 
“Movie time!”. 

 
Example: (Multiple command phrase with multiple responses) 
 
 Spoken Phrase: theater mode 
 Keystroke: “IRR=AMP POWER~IRR=VCR POWER~X10=A5 OFF~IRR=VCR PLAY” 
 
 Spoken Phrase: Theater light off 
 Keystroke: “X10=A5 OFF” 
 Responses: light off 
 
 Spoken Phrase: amp power 
 Keystroke: “IRR=AMP POWER” 
 Responses: stereo on 
 

In this example since there is no response for the spoken phrase “theater mode”, 
HomeVoice™ then looks for a match for each command issued. If a match is found then a 
response for that command is produced. So for this example, the response for the phrase 
“theater mode” would be “stereo on” followed by “light off”. 

 
In this way it is possible to have multiple responses issued for a string of commands or to only 
have one response for a string of commands.  
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You can create any response that you would like the computer to answer with. Punctuation and 
grammatical symbols such as accents will change the way in which the response sounds. See 
Using the voice synthesizer capabilities of HomeVoice™ for details on this topic. 
 
When a single response is issued for a string of multiple commands, the response will be issued 
prior to the commands being sent to the controller. When there is a response for each command 
or a single command, the response will be issued when the controller acknowledges receipt of 
the command.  
 
The first time a response is issued when the system is brought up, there will be a slight delay. 
 
A response is only verification that the controller received the command okay.  It does not 
guarantee the controller carried out the command properly. 
 
WAVE (.wav) sound files may be played in response to commands. You can mix WAVE files and 
normal responses. 
 
We recommend that you use whatever responses you wish.  Have some fun with it.  Please be 
aware that you don’t need to have a voice response for every command. For example, if you 
have a command for turning on a light, you may not wish to have the computer reply with a voice 
response.  The fact that the light turns on can be sufficient feedback to know your command has 
been obeyed.  For commands that do not provide such overt action, we do recommend that you 
use a voice response phrase to confirm that the computer has issued the appropriate command.  
For example, if you were activating your burglar alarm, it would be reassuring to hear the 
response, “Alarm Active”. 
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1.6.7.2 Sleep Mode Response (optional) 
 
As mentioned earlier, HomeVoice™ has two modes of operation, sleep mode and awake or 
active mode. When changing from sleep mode to active or awake mode, a response to the 
wakeup command is specified for the wakeup command. In order to provide the user feedback 
when HomeVoice™ changes from awake or active mode to sleep mode through automatic time-
out, a dummy command with responses is added to the users active command vocabulary. 
 
The spoken phrase “sleep response” with two double quotes in the keystrokes field is used to 
allow users to program a system response when HomeVoice™ goes to sleep. 
 
Use of a simple “ding” wave file or short phrase, is recommended so that the user knows when 
HomeVoice™ needs to be woken up again to issue voice commands from his or her command 
list.  
 

 
 
 

1.6.8 Response Only Commands 
 
If you want to speak a voice command with the only action being a response (i.e., no commands 
are issued to the controller), be sure to place “ ” (two double quotes) in the keystroke field of the 
spoken phrase.  The two double quotes are the HomeVoice™ null command.  Without the null 
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command, you will not receive a response. HomeVoice™ will only play a response if a command 
is successfully issued. 
 

1.6.9 Command Verification Setup 
 
In order to setup a command for verification the first character of the keystroke field must be an 
asterisk "*". This must proceed all other characters even the X10 or IRR or whatever is there, 
(e.g. "*X10=A1 ON"). When HomeVoice™ see this character is will prompt the user as specified 
in the "Verification Prompt" setup see below for details on changing the verification prompt. When 
prompted for verification HomeVoice™ will listen for a phrase from the "Verification" list before 
carrying out the command. If no verification is provided in 10 seconds or if anything other than a 
verification phrase is heard HomeVoice™ will ignore the command and go back to listening for a 
new command. While any command other than those contained in the "Verification" list, will 
terminate the command execution, the list "Negative_Verification" is provided and used for telling 
HomeVoice™ not to execute the command. See "List" later in this document and the "Listen 
Users Guide" for more details on dealing with lists. 
 

1.6.10 Command Authentication 
 
In addition to command verification HomeVoice™ now provides the ability to password protect 
commands. Password protection is to allow a minor level of security to restrict the use of certain 
commands. Each user may setup their password via the menu options described below. In order 
to setup a command for password authentication, you must set it up for verification as described 
above. With the addition of one more character prior to the command HomeVoice™ will prompt 
for the password after the verification prompt has been approved. By adding the "at sign" "@" 
after the asterisk "*" a command will prompt for a password. If the password does not match that 
set by the user the command will not be executed. (e.g. "*@X10=A1 ON"). During the password 
recognition process HomeVoice™ will tighten down the recognition algorithm as much as 
possible to do what it can to make spoofing as difficult as it can. DO NOT CONFUSE THIS WITH 
A VOICE PRINT!! It can be spoofed and should not be used for disarming security systems or 
other vital systems. 
 
The password is passed to HomeVoice™ in the keystroke field. A list is provided "Password" 
which is an example of what can be setup for password usage. It is a four-digit number using the 
digits 0-9. A command can be setup such that the spoke phrase is "The password is 
"%Password"" and the keystroke field is just "%Password". In this way the user can respond to 
the password prompt "The password is 1234" and then if 1234 matches the password set by the 
user the command will be executed. 

1.7 How to Edit Existing Commands 
 
(This section is valid only for Windows 95 and 98 all other operating systems refer to the following 
section 1.8) 
 
To edit or tailor an existing command, highlight the command in the “Verbex Listen” window. 
From the Edit menu, select Edit Selected Phrases.  Creating or editing commands can also be 
accomplished through the Listen Command Editor (LCE). This method is recommended if you are 
adding, editing, or deleting more than one or two commands. See Section 6.8 for more 
information. 
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The “Edit Phrase” window will appear.  Edit the Spoken Phrase if desired and/or change the 
Keystroke field to change the command string sent to the controller.   

 

To highlight more than one command you can highlight the 
command and hold down the right mouse. Next, keeping 
the right mouse button held down, drag the mouse down 
the screen and stop when all commands to be edited have 
been selected. If the commands that need to be edited 
aren’t in sequential order, then simply hold down the 
control, (Ctrl) key while selecting commands. Proceed to 
the Edit menu button and choose Edit Selected Phrases. 
The Edit phrase window will appear, by default the 
keystroke expansion field will be unchecked. This field 
allows for keyboard strokes to be entered directly in the 
keystroke field. Instead of a space appearing between 
commands the actual command <SPACE> would appear. 
HomeVoice™ can accept this type of formatting but in the 
case of multiple commands for one spoken phrase you 
may run out of room to put the commands in the keystroke 
field. 
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The previous example is an X-10 command.  The following example shows an Infrared command 
needing to be edited. Follow the same procedures, as above but instead of X-10 command string 
syntax, you must use the appropriate syntax for an Infrared command.  
 

 
 
When your changes are complete, click Save.  The system will rebuild the voice files and a 
window will appear that shows the progress of the rebuild process. 
 

  
 
When the rebuild is complete HomeVoice™ is again ready for use. 
 
Note: Use only lower case when entering the voice command text in the Spoken Phrase area.  
The “Verbex Listen” voice recognition engine, unlike HomeVoice™ in general, is case sensitive 
and prefers to have lower case commands. 
 
Note: There is a known bug that users need to be aware of when building new commands and 
editing existing commands.  When the editing changes are completed and rebuilt, sometimes the 
Verbex window is not refreshed properly.  There are two work arounds for this problem, click the 
microphone icon on the recognized text bar twice to toggle the microphone off and then on. The 
other method is by issuing the “Stop Listening” voice command and putting HomeVoice into sleep 
mode.  When you wake it up with your wakeup command, the Verbex window should be 
refreshed with the changes you made. Another method is to click on the microphone button on 



Copyright 2002 Applied Future Technologies, Inc. 1-24

the recognized text bar turning the microphone off and then back on again. This will refresh the 
window exposing the commands. 

1.8 Adding or editing Multiple Commands 
 
The software allows a process to make multiple changes or additions to your voice commands in 
the “Listen” engine.  In the “Verbex Listen” window, select Start Command Editor from the Edit 
menu. 
 
 

 
This will bring up a “Listen Command Editor” dialog box.  

 
 
 
At this point you can edit Existing Phrases or add New Phrases. To add a new phrase, click on 
the New Phrase button.  To edit a phrase, select the phrase and click on the Edit Phrase 

The limit to multiple command strings on any 
one spoken phrase command is ten total X10, 
Infrared and/or ASCII (or a combination thereof).  
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button. Both Buttons will bring up the window that will allow you to add/edit spoken phrase voice 
commands as well as add/edit the keystroke field. See How to Edit Existing Commands for the 
screen details involved with adding or editing a specific command. 

1.9 Adding New Users 
 
To add new users, chose the Setup drop-down menu in the ‘Verbex Listen’ window.  Then select 
New User. 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
If prompted, click Yes to sample the noise environment. The sample noise option will allow 
HomeVoice™ to measure background noise to allow for operation in noisy environments.  The 
software will measure the relative ambient background noise and then listen for identified 
commands against that background. This completes the new user setup.  
 

Do not change the sub 
directory field as it is 
directly related to your 
user ID. Both the response 
and the Listen™ library 
files reference this Sub 
Directory. For proper 
operation, we recommend 
this field remains 
unchanged. 

When prompted, select your 
voice gender. Males under 14 
should select female. Adult 
males have deeper base tones 
than females while the female 
voice is softer and not as deep. 
Use of this selection is correct for 
a young male’s voice recognition 
since their voice has not 
developed yet and is still 
considered to be soft. Click on 
OK and continue. 
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1.9.1 Copying User Files to New Users 
 
When adding new users, it is convenient to copy an existing user's commands to the new user. 
This way, you do not have to rebuild every command for every new user to work with the 
automation setup in your home.  You can also change the base set of commands every new user 
gets when a new user is setup. 
 

1.9.1.1 To copy the current users’ commands to a new user. 
 
Create the new user as described above, then from the Listen Setup menu change users back to 
the user with the commands you want to copy. Then from the Start Menu start Microsoft Windows 
Explorer. Using Windows Explorer copy the following files from the current users directory to the 
new users directory. 
 
Homevo.grm 
Homevo.rec 
Global95.inc 
 
From:  \Homevoic\LFW40\<current user directory> 
To: \Homevoic\LFW40\<new user directory> 
 
  Where the actual names are substituted for, <current user directory>  

and <new user directory>. 
 
 
When completed, the new user’s voice commands will be the same as the current user whose 
voice commands were copied. From the Setup menu Listen window select Change User and 
switch to the new user. Start the command editor, it may prompt you to rebuild the HomeVoice™ 
Speech Interface, if so proceed with the rebuild. Verify the commands are those desired and 
make any modifications specific for the new user. 
 

1.9.1.2 Changing the Base Commands for New Users 
 
To change the default commands all new users get when they are created from the defaults 
shipped with the software.  Follow the following procedure: 
 
When you have your base set of commands completed, from the Start Menu start Microsoft 
Windows Explorer. Using Windows Explorer copy the following files from the user directory with 
the base command set to the LFW40 directory and make changes to the filenames as shown. 
 
Current Name   New Name 
Homevo.grm   Homevo.crm 
Homevo.rec   Homevo.cec 
Global95.inc   Global95.cnc 
 
From:  \Homevoic\LFW40\<base commands user directory> 
To: \Homevoic\LFW40 
 

Where the actual names are substituted for, <base commands user directory>. 
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When completed, all new users created will have the base voice commands to start with as those 
which were copied. 
  
The new user can use the adding and editing processes described in How to Edit Existing 
Commands to change and personalize these copied commands. 

1.10 User Preferences - Timeout Value and Sample Noise 
 
 

 
 
Note: For proper synchronization between HomeVoice™ and Listen the timeout value should be 
set through the HomeVoice™ options menu. 

To change user preferences, chose the Setup drop-
down menu in the ‘Verbex Listen’ window.  Then 
select User Preferences.  
 
The Timeout Value is the duration of time that 
HomeVoice™ will remain awake listening for a valid 
voice command phrase.  The initial timeout value is 
either set as a program default or in the 
HomeVoice™ installation process. The timeout value 
can be changed in the Sleep Mode box.  Change 
the value in the Enable Timeout box. 
 

To turn off the request to 
sample the ambient 
background noise when 
HomeVoice™ is started, de-
select the check-box on the 
Sample Noise option. 
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1.11 Wakeup Command Syntax 
 
The command syntax for the wakeup commands is a specific string.  For each wakeup voice 
command phrase, the following string must be input in the keystroke box when creating the 
command: 
 
 “\200\004\020\021\021\020” 
 
The voice recognition engine software requires this specific content. Further explanation of the 
coding of this string is irrelevant to operation of HomeVoice™ and is not provided to users.  
Failure to use this string will result in unreliable operation. 
 
 

1.12 Changing Users via Voice Command 
 
To change the user via voice command in HomeVoice™, you must use the following command 
syntax: 
 

user=<username> 
 

The reason for changing users via voice is to allow HomeVoice™ to switch from one user’s set of 
commands to another user’s set of commands.  
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This command is entered in the keystroke field when entering commands in the Listen 
Command Editor. In general, these commands should be entered in the "Wakeup" grammar so 
that you may switch from one user’s set of commands to another.  In the above example, Lynn is 
placing a command in another user’s wakeup command list that will allow HomeVoice™ to switch 
to Lynn’s set of commands. This can be done when “Listen” is asleep by selecting Add New 
Phrase under the Edit menu in the “Listen” window. After making the change, Lynn should go 
into the other user’s wakeup command list and train his switching command in his voice (using 
train selected phrase).  The other user should place a similar voice switch command in Lynn’s 
wakeup command list to allow him to switch to his list of commands if Lynn’s user is active. 
 

 
 
Another option is choosing Listen Command Editor from the “Listen” window Edit menu and 
then selecting the Wakeup grammar by double clicking on it in the left side of the dialog 
displayed.  
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In the example below the current user is placing a command in his wakeup grammar to change to 
user “Steve”. 
 

 
 
Then click Save and the voice files rebuilt. After saving, train the command to the appropriate 
user voice.  In this example, Steve would voice train the command in the current user’s voice file.  
When the command "computer recognize steve" is recognized by HomeVoice™, it will switch to 
user “steve” and load his commands and grammar files. In this way HomeVoice™, can be 
configured for use by multiple users. 
 
For switching users to work properly, each user should also turn off the "sample noise on startup" 
option. This is done by, selecting the User Preferences option from the Setup menu on the 
“Verbex Listen” window User Preferences.  HomeVoice™ will automatically sample the noise 
whenever switching users by voice command if this option is not disabled. 
 
This process needs to be done for all users of the system if you will be switching any users by 
voice.  
 
You may also change users by clicking on the user list box found in the in the “Verbex Listen” 
window.  
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If you change users in this manner you must select Refresh Response from the File menu in the 
“HomeVoice™” window to load the responses for the new user.  
 

 
 
This refresh response is done automatically when switching by voice command. 
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1.13 HomeVoice™ Menu Options 
 
The following sections discuss the HomeVoice™ pull-down menu functions.  

1.13.1 File Menu 
 
The following list discusses options under the File Menu in the HomeVoice™ Window: 
 
Refresh Response 

 
Reloads the responses for the current user into memory. Use this option after changing 
your responses to update your responses in HomeVoice™ memory. 
 

Refresh Infrared 
 
Reloads the Infrared database descriptions into memory. Use this option after changing 
your Infrared database by adding commands or changing descriptions in the database.  
 

Controller Setup > 
 

 This option is for adding or changing controller configurations. 
 

Exit 
 

 Exits the HomeVoice™ application. 
 
 

1.13.2 Watch Menu 
 
The below list discusses options under the File Menu in the HomeVoice™ Window.  The options 
under the Watch menu are used for debugging problems in grammars and commands. 
 
Command 

 
By checking the Command option HomeVoice™ will display the recognized phrase and the 
keystroke field in the HomeVoice™ window, as well as some high-level communication 
information. 
 

Advanced 
 
By checking this option HomeVoice™ will display the commands being sent and received 
on the serial interface to the HomeVoice™ window, in both actual and hexadecimal 
formats. 
 

Show Settings 
 

Show the current settings in the HomeVoi2.ini file 
 

Display IR  (Only with learning IR capable controllers) 
 
This option will display the values for the IR database that it has loaded in memory. 
 



Copyright 2002 Applied Future Technologies, Inc. 1-34

Clear 
 
The Clear command will clear all text from the HomeVoice™ window. This command does 
not clear the current settings. 
 

 
 

1.13.3 Options Menu 
 
The following discusses options under the Option Menu in the HomeVoice™ Window: 
 
Stop Voice 

 
This sends a signal to HomeVoice to terminate the speech synthesizer. It is included for 
terminating the reading of text files that can get rather lengthy. It can be difficult to get the 
menu to come up when the speech synthesizer is active. It is possible with two deliberate 
mouse clicks to "get through" the Windows cycles and not actually see the menu. This is 
way this holds the first position in the menu. You can click on the Option menu and then 
move the mouse down to where the "Stop Voice" menu will appear and click again. These 
actions will be queued to the operating system and usually get though between synthesized 
segments. 
 
Note: This can also be accomplished via X10 when a controller that supports two way X10 
with HomeVoice. See X10 Event Processing later in the documentation. 
 
 

Thresholds 
 
HomeVoice™ allows for making adjustments in the recognition algorithms used by 
HomeVoice™. Caution should be exercised in changing these parameters. It is often 
more productive to choose words with more syllables to improve accuracy and reduce 
misfires.  Adjustments to the recognition algorithm may be made to the HomeVoice™ sleep 
mode as well as the active mode. In most cases the values set are adequate. However in 
certain situations it may be desirable to make changes to improve recognition accuracy.  
These parameters allow the user to tighten or loosen, the two main parameters, which 
determine how tightly the recognition engine forces a pattern match for the words and 
phrases heard. The lower the parameters value the tighter the recognition algorithm.  
 
As a rule of thumb when adjusting these parameters the coarse adjustments can be done 
‘5’ at a time while the fine adjustments should be done ‘1’ or ‘2’ at a time. These parameter 
changes will take effect on closing the dialog. Make adjustments until the proper settings 
are determined. 
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Note: These parameters are system wide so that changing them for one user will 
change them for all users. 
 

Noise Sampling 
 
When changing users via voice command, i.e. “user=steve”, HomeVoice™ will by default 
sample noise after changing users. This may be disabled by selecting Sample Noise Menu 
and unchecking “When Changing Users” option. 
 

Timeout Value 
 
The Timeout value can be set from the HomeVoice™ Options menu, by selecting the 
Timeout Value option. Specifying a value of zero will disable HomeVoice™ from going to 
sleep. When choosing a value for the timeout value the user should consider the length of 
responses they have set for their commands. Setting a short timeout with long responses 
means the user will have to keep waking up HomeVoice™ to issue multiple voice 
commands. Each user may set their own desired timeout values. The timeout values starts 
at the end of the last recognized phrase received, not at the end of the last response 
issued. 
 

 
 
Verification Prompt… 
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The Verification Prompt dialog is for setting how the system will respond when it receives a 
command requiring verification before it can be executed. When HomeVoice™ receives a 
command with an asterisk "*" as the first characters of the keystroke field it will issue a 
response prompting for verification to execute the command. The default response prompt 
is: 
 

  "I heard the command, <recognized command>, shall I execute?" 
 
   Where <recognized command> is the actual phrase recognized by the 
Verbex Listen engine. 
 
To customize this response to your own personal tastes select the Verification Prompt… 
menu. The dialog below will be displayed. 
 
If you wish a completely custom response, which does not contain the spoken phrase, 
select custom and input your prompt. 

 
If you would like a prompt which appends the phrase heard to the end of your custom 
prompt Select "Custom Plus Spoken Phrase". If you want to get more elaborate you may 
select "Custom Multipart". This will display the dialog below. In the "Prompt" field enter the 
first part of the verification prompt. In the "End Prompt" field enter the last portion of the 
prompt. The prompt for verification in this setting is:  
 
  <Prompt>, <Spoken Phrase>, <End Prompt> 
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So in this example if the phrase "Arm security night mode" was heard and the first character of 
the keystroke field was an asterisk "*". The prompt, from HomeVoice™ would be: 
 

"Verify, arm security night mode, was heard." 
 
Wave File Path… 

 
The Wave File Path… dialog is shown below. This dialog allows you to provide a directory 
location where HomeVoice™ will look for wave files, which are specified as responses. The 
default is the HomeVoice™ installation directory.  

 

 
 

Text File Path… 
 
The Text File Path… dialog is shown below. This dialog allows you to provide a directory 
location where HomeVoice™ will look for text files, which are specified as responses. The 
default is the HomeVoice™ installation directory.  
 

 

 
Command Logging… 

 
Command logging is provided primarily as a method for problem isolation. By default 
command logging is disabled so when selecting command logging for the first time the 
dialog below will be displayed. 
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By clicking on the "Logging On" button the dialog below will be displayed.  
 
 
 

 
The "Log File Directory" specifies the location where log files are to be created and stored. 
The "Current Log File Name" shows the name the log file will have unless you change it. 
The default log file is the current data and time. The "File Size Limit in Kilobytes" is the 
setting to tell HomeVoice when it should create a new file and start logging to the new file. 
 
The "New Log File" will force creation of a new log file. 
 
The "Logging Off" button will turn logging off. 

 
HomeVoicePC  

 
Selecting this option allows Listen for Windows to switch speech interfaces and control 
different applications. Applications may be switched to and started via voice commands 
to the PC. Speech interfaces for applications are created using the Listen Command 
Editor. 

1.13.4 Security Menu 
 
 
 Set Password… brings up the following dialog. 
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Enter your password in the first window and then verify the password in the second edit box. Click 
on OK when done. 
 
  Change Password… brings up a dialog to change your password after it has been set. 
You must know your current password in order to change your password. Once you have input 
your current password you will receive a dialog for changing your password. 
 
 

1.13.5 About Menu 
 
The following discusses option under the About Menu in the HomeVoice™ Window: 
 
About HomeVoice… 

 
Displays information about the current version of HomeVoice™. 

 

2 Miscellaneous 
 

2.1 Using LISTS in HomeVoice™ 
 
The Listen Command Editor (LCE) is used to input multiple commands as well as create speech 
interfaces for other programs. In addition to these options, the LCE can also be used to create or 
edit lists. Under the LCE window, select Lists... from the Edit menu.  
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Lists are used to create various components of the speech interface. Instead of using a single 
command for each channel, a list of channels can be created.  
 
Note: Lists must be consistent within a users grammar. You can not have two lists with different 
names which have the same elements but which have different keystroke mappings. In this 
situation there is confusion about which keystroke to send and the results are unpredictable. 



Copyright 2002 Applied Future Technologies, Inc. 2-41

 
 
This channel list would range from 1 - 9 and would cover all channels from 1 - 99.  
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In addition to number lists, word lists can also be used for better recognition in high noise 
environments. 
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2.2 Timing Issues 
 
HomeVoice™ synchronizes sending commands based on the responses from the controllers. 
HomeVoice™ provides a "PAUSE" command for introducing delays between commands sent to 
the controller. If you are having problems with timing add a pause command between the 
commands you are having problems with. If you do not want to use a pause command you may 
try restructuring the command sent to the controller. In general, this may only occur when sending 
a string of commands to the controllers. It may be necessary to intermix X-10 and Infrared 
commands to adjust the timing performance of the command string because X-10 commands will, 
in general, take longer than Infrared.  Another option is to use responses for the individual 
commands to adjust the timing by slowing things down. 
 

2.3 HomeVoi2.ini File 
 
Overview 
 
HomeVoice™ 2.3 uses a new initialization file "HomeVoi2.ini". The new initialization file has 
multiple sections depending on the number of controllers in use. With HomeVoice™ 2.3 we have 
added the ability to use multiple controllers in order to allow greater flexibility and design 
capabilities. With HomeVoice™ 2.3 a default controller is required, optionally a separate 
controller can be specified for Infrared and X10 commands. The default controller setup 
information is specified in the [Default_Controller] section. The two optional controller setup 
information is specified in the [X10_CONTROLLER] and [IR_CONTROLLER] sections. With the 
use of these sections it is possible to use three different controllers at the same time. The default 
controller is required and will process all commands, unless either and X10 controller and/or and 
IR controller is specified. If an X10 controller is specified then this controller will process all 
commands starting with X10. If an IR controller is specified then that controller will process all 
command starting with IR. The default controller will handle all other types of commands. The 
thresholds section keeps track of the threshold settings which were not tracked previously so 
when the software had to be restarted these settings had to be manually reset. The [watch] 
section tracks the value of the watch menu settings. The [HomeVoice] section tracks the settings 
specified for various HomeVoice™ system level parameters. These parameters are set via the 
HomeVoice™ options menu. An example of this file follows. 
 
Example HomeVoi2.ini file: 
 
[DEFAULT_CONTROLLER] 
controller=OMNI 
comport=COM1  
baudrate=9600 
basehousecode=A 
 
[X10_CONTROLLER] 
controller=HOUSELINC 
comport=COM2 
baudrate=9600 
 
[IR_CONTROLLER] 
controller=HOMEISA 
ir database=c:\homevoic\irdata.dbf 
 
[Thresholds] 
SleepThreshold = 45 
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SleepRelThreshold = 45 
ActiveThreshold = 65 
ActiveRelThreshold = 55 
 
 
[Watch] 
Commands=0 
Advanced=0 
 
[HomeVoice] 
HomeVoicePC=0 
SampleOnChange=0 
WaveDirectory = C:\HomeVoic 
TextDirectory = C:\HomeVoic 
VerificationPrompt = Default 
Prompt = Verify 
Prompt1 =  
CommandLogging = FALSE 
LogFileDirectory = C:\HomeVoic 
 

2.4 HomeVoic.ini File  
 
The HomeVoic.ini file is located in the HomeVoice™ installation directory. With HomeVoice™ 2.3 
this file is used only for Infrared controllers. This file contains information about the Infrared 
controller that is being used, comm port and baud settings and location of the Infrared database 
to be used. The structure of the HomeVoic.ini file is very important.  The following examples 
should be used in reference to the home controller you are using. In general, format of the 
HomeVoic.ini file is as follows, please refer to the section on your specific controller to understand 
the deviations from the general format. 
 

Line 1: Controller   
Line 2: Serial Port settings 
Line 3: Infrared database file 

 
HomeISA™ 
 

HomeISA   
Yes 
C:\HomeVoic\irdata.dbf 

 
Note: As the HomeISA™ controller does not use a serial port the second line specifies whether 
or not responses to X10 events should be issued. 
 
If the line is “yes” HomeVoice™ will issue a response for the specific command received and if 
such a response is setup in the active users command set. If the line is “no” HomeVoice™ will 
ignore received X-10 events. 
 
Houselinc and PROXi 
 

Proxi 
COM1 baud=9600 parity=n data=8 stop=1 
none 

 



Copyright 2002 Applied Future Technologies, Inc. 2-45

Note: As the PROXi system does not have an Infrared database but uses predefined 
commands the third line is set to “none”.  

 
Homebase 
 

Homebase 
COM1 baud=2400 parity=n data=8 stop=1 
C:\HomeBase\ir.dbf 

 
JDS Time Commander and Time Commander Plus 
 

JDS 
COM1 baud=2400 parity=n data=8 stop=1 
C:\WinEVM\ir.dbf 

 
JDS Stargate 
 

JDS 
COM1 baud=9600 parity=n data=8 stop=1 
C:\stargate\ir.dbf 

 
IBM Home Director and X10 Active Home (CM11A) 
 

CM11A 
COM1 baud=4800 parity=n data=8 stop=1 
NONE 

 
Note: As the CM11A does not support Infrared operations the third line is set to “none”. 
 
HomeVision 
 

HomeVision 
COM1 baud=19200 parity=n data=8 stop=1 
C:\HomeVis\schedule.hvx 
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2.5 Time and Date Commands 
 
This section discusses how Time and Date responses can be requested from HomeVoice™. This 
information is true for all controllers. HomeVoice™ provides three commands for receiving the 
current time and date information from HomeVoice™. These commands are entered in the 
Keystroke field. The three commands are: 
 
 time 
 date 
 timedate 
 
One of these three commands is the only thing which should be in the Keystroke field. 
 
Example: 

 
 
Do not add any additional responses for this command. Click Save and rebuild the interface. 
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2.6 Changing or Adding New Infrared 
 
If you update or make changes to the Infrared databases while HomeVoice™ is operational then 
you must update the corresponding data in HomeVoice™. Selecting Refresh Infrared from the 
File menu in the HomeVoice™ window does this. 
 

 
 
 

2.7 Changing Voice Responses while HomeVoice™ is Active 
 
If you update or make changes to the response field of a spoken command while HomeVoice™ is 
operational then you must update the data in HomeVoice™. Selecting Refresh Response from 
the File menu in the HomeVoice™ window does this. 
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3 The Speech Synthesizer 

3.1 Using the voice synthesizer capabilities of HomeVoice™ 
 
The HomeVoice™ voice synthesizer analyzes input text and automatically assigns stress to 
simulate natural intonation and co-articulation patterns. You may alter the input text to force a 
stress pattern or create special effects in the spoken phrase window when adding or editing a 
voice command phrase. 
 

3.1.1 Creating Pauses for Special Effect 
 
To create a slight pause for special effect, insert two or more greater than marks ( >> ) preceded 
and followed by at least a single space. These marks should be inserted between any two words 
in the text to be synthesized, as follows: 
 

•  For a short pause insert 2 greater than marks ( >> ). 
•  For a longer pause, insert 3 greater than marks ( >>> ). 
•  For the longest pause insert 4 greater than marks ( >>>> ). 

 
For example to give emphasis to "master" in the sentence "Yes master, what is your command.", 
the phrase would be entered: 
 

"Yes, master >>> what is your command.". 
 

3.1.2 Altering stress in text. 
 
To alter stress in text, insert two left or right brackets preceded and followed by spaces 
immediately after the word whose stress is to be changed, as follows: 
 
To give special stress to words not ordinarily stressed insert into the text immediately after the 
word to be stressed 2 left brackets ( [[ ). 
 
For example, to stress the word "not" in the phrase "I do not want to turn the light off" enter: 
 

"I do not [[ want to turn the light off." 
 
To take stress away from words ordinarily stressed, insert two right brackets ( ]] ) immediately 
after the word to be de-emphasized. For example, to de-emphasize the word "off" in the phrase "I 
do not want to turn the light off" enter: 

 
"I do not want to turn the light off ]] .". 

 
Example of using both: 
 

"I do not [[ want to turn the light off ]] .". 
 
 

3.1.3 Creating Intonation with Punctuation Marks 
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To create special intonation in text where it ordinarily does not occur insert punctuation marks into 
the text as follows: 
 
To insert puzzlement about a certain word inside a sentence insert a question mark immediately 
after the puzzling word. 
 
For example, "I turned the light off. " can become: 
 

"I turned the light? off." 
 
To change a declarative sentence into an interrogative sentence, change the final punctuation 
from a period (.) or exclamation mark (!) to a question mark (?).  For example "Turning the 
lights off.", can become: 
 

"Turning the lights off?" 
 
To insert joyful emphasis about certain words inside a sentence insert a comma (,) immediately 
after the joyful word.  For example, "Turning the lights off." can become: 
 

"Turning,  the lights off." 
 
To insert solemn emphasis to certain words inside a sentence, insert a period (.) immediately 
after the joyful word.  For example, "Turning the lights off." can become: 
 

"Turning.  the lights off." 
 

3.1.4 The User Dictionary Utility 
 
The User Dictionary Utility makes it possible to control how the voice synthesizer speaks certain 
exotic English words or non-English words which require special pronunciation and accenting.  
Quite often, the voice synthesizer will speak the words acceptably; however, when different 
pronunciation is required, the user must add the special words to the User Dictionary and specify 
how the word should be pronounced. 
 
The User Dictionary Utility allows the user to manipulate the synthesizer dictionary.  You may add 
words, delete words or change the pronunciation.  To start the User Dictionary Utility: 
 
 Click the Start button 
 Select Run.. 
 Enter x:\path\lfw40\userdict\Userdict.exe 
 
where: 

x is the drive you have HomeVoice™ installed (for example “C”) 
path is the directory structure where HomeVoice™ is installed (for example, “HomeVoic”) 

 
 Click OK 
 
The main window gives you four menu options, Add Word, Delete Word, View Dictionary, and 
Exit.  Use the Exit option to end the User Dictionary Utility. 
 

3.1.4.1 Add Word 
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Clicking Add Word will bring up the Add Word Dialog box.  Type the word you wish to add or 
change in the Word box.  In the Phonetic box, enter the phonetic coding for the word being 
added or changed. 
 
To phonetically encode a word, select the phonetic characters from the Phonetic Alphabet 
included in the Add Word Dialog box.  The list labeled Vowels represent valid vowel phonetic 
characters. The list labeled Consonants represent valid consonant characters.  For example: 
 
 drop  dro’p 
 teacher te~c~u| 
 democratic demukratik 
 
You may insert an accent mark or marks.  The slash character “/” represents the primary accent 
mark.  The back slash character “\” represents the secondary accent mark.  Use the accent 
marks as follows: 
 

- If the word contains a single vowel, insert the primary accent mark immediately after the 
vowel and before any consonants, which follow the vowel.  For example: 
 
 drop  dro’/p 
 
- If the word contains two or more vowels and has only one accent, insert the primary 
accent immediately following the vowel needing the accent and before any consonant 
following that vowel.  For example: 
 

  teacher te~/c~u| 
 

- If the word contains two or more vowels and contains more than one  accent, insert the 
primary accent and the secondary  accent marks immediately following the vowels 
needing those accents and before any consonant following those vowel.  For example: 
 
 democratic de\mukra/tik 

  
 
- Usually, a word has only one primary accent.  Any secondary accents always come 
before the primary accent. 
 

Click on the Click button to check if the pronunciation is acceptable.  If not, re-encode and 
continue testing until satisfied. 
 
Click on the Add button to add the latest change to the User Dictionary. 
 
Click on the Done button to add the latest change and return to the Main Window. 
 
Click on the Cancel button to return to the Main Window without adding the latest change. 
 
 

3.1.4.2 Delete Word 
 
Clicking Delete Word will bring up the Delete Entry from User Dictionary Dialog box.  To delete 
a word from the User Dictionary, click on the word you wish to delete.  The word will be 
highlighted.  Click on the Delete button. Click OK to return to the Main Window.  
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3.1.4.3 View Dictionary 
 
Clicking View Dictionary will bring up the View Dictionary Dialog box.  In the view dictionary 
mode, changes cannot be made to the spelling or phonetic encoding of an entry.  Each entry in 
the User Dictionary appears with the spelling of the word on one line and the phonetic encoding 
on the next line.  Use the scroll bar on the right hand side of the dialog box to move through the 
list of words.  Click OK to return to the Main Window. 
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4 HomeVoice™ Technical Support 
 
HomeVoice™ technical support for registered users is available by calling Applied Future 
Technologies, Inc. at 303-403-0457 or 800-790-3353.  Our email address is 
support@appliedfuture.com.  Our web site: 
 

 http://www.appliedfuture.com  
 

will be updated with future product information, FAQs and other information related to 
HomeVoice™ and home automation. We realize that most homeowners are only available at 
night and weekends to work on home projects. After hours support is available, please call 303-
403-0457 or 800-790-3353 and let us know if and when this support is needed so we may 
schedule a time, which is convenient to the HomeVoice™ user. 
 
 

4.1 Other Products from AFT 
 
AFT offers several related products for controlling your home using voice command capabilities.  
 
HomeISA™ is our exciting and inexpensive home automation controller product. HomeISA™ is 
built as an ISA PC card and is capable of X-10 and IR control (two zones) and has 2 analog 
inputs that can be used for temperature sensors.  AFT’s HomeISA™ Kit includes the HomeISA™ 
card and software interface, HomeVoice™ software for voice control, a PZM Sound Grabber 
microphone for excellent voice pickup, an  X-10 powerline interface module with a cable, an X-10 
powerline lamp module, an IR emitter, an IR receiver for training the IR commands and a 
temperature sensor. HomeISA™ offers significant capability for an affordable price and gives you 
the basic foundation to build a voice-controlled solution for your home.  
 
Our HomeVoice™ Multi-Room Kits have been assembled and tested to allow you to expand 
voice control throughout your home.  Each HomeVoice™ Multi-Room Kit includes the 
HomeVoice™ software (call us for a price adjustment if you already have the software), PZM-11 
microphones for the number of rooms ordered, and a mixer and sound gate to combine the 
multiple microphone inputs into your PC’s single input.  The components on these kits have been 
successfully used in home automation systems designed and installed by AFT.  The included 
PZM-11 microphones provide superior and reliable voice pickup.  The HomeISA™ card can be 
added to a HomeVoice™ Multi-Room Kit if you need a cost effective controller solution (call us for 
pricing). See the included Data Sheet for more information on our HomeVoice™ Multi-Room Kits.  
 
To order any of these products or for additional information, visit our web site at 
http://www.appliedfuture.com or call Applied Future Technologies, Inc. Sales at 303-403-0457 
or 800-790-3353.  Our email address is sales@appliedfuture.com.   
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5 Trademarks  
 
HomeVoice™ and HomeISA™ are trademarks of Applied Future Technologies, Inc. all other 
trademarks or registered trademarks are properties of their respective owners. 
 
 

6 Appendix A: X10 Event Processing 
 
HomeVoice™ can respond to X10 events when used with the HomeISA™, IBM Home Director 
(CM11A), X10 Active Home (CM11A), Houselinc and JDS controllers. In order to use this feature 
a text file, named "X10EventFile.txt" must be created in the HomeVoice™ installation directory.  
This file can then be edited to specify which X10 events the user want to have responses for. The 
response for an X10 event can be a voice response as specified in the response section above, 
or can be a command or set of commands as specified in the X10EventFile.txt. Each line of the 
file contains the X10 event and the comand or commands which are to be executed in response 
to the event. The format of the line in the file is: 
 

X10 Event; commands; response 
 
Each field is separated by a semi-colon (;). The X10 event is specified as listed above in the X10 
section (e.g. A5 ON). The commands are specified in the standard format for HomeVoice™ 
keystroke field. Each command to be executed is separated by the tilde character (~). The 
response field is text to be passed to the speech synthesizer or the name of a wave file to be 
played or a text file to be synthesized.  For example the entry: 
 

A5 ON; X10=B1 ON~IRR=VCR RECORD; motion sensor triggered 
 
Specifies that, if the command "A5 ON" is received on the power-line, the command "B1 ON" is to 
be sent followed by the Infrared command "VCR RECORD". The speech synthesizer will speak 
the phrase, "motion sensor triggered". 
 
If only a voice response is desired the command section can be left empty, although at least on 
space is required, but the semicolon delimiter must still be present. For example the entry: 
 

B7 ON; ; Someone is at the door. 
 
Will speak the phrase "Someone is at the door." if the signal "B7 ON" is received. 
 

7 Appendix B: Commands supported for HouseLinc from 
SmartLinc Inc. 

 
The commands documented below are placed in the keystroke field for the command. Please 
consult your Houselinc documentation for specifics relating to any of the commands listed here. 
 
X10 Commands 
 
For sending X10 commands all standard X10 commands in the format specified earlier are 
supported. X-10 Commands for complete details of X10 commands and syntax. 
 
Infrared Commands 
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The Houselinc controller is based on the universal chip for Infrared control. It has a set of 
standard "keypad buttons" programmed into the chip. The IR command set is as follows: 
 

A B C MAGIC 
AUX AUX2 VCR TV 
CABLE CD TUNER AMP 
A/B SHIFT DISP REC 
AUD VID PGM MUTE 
CHUP CHDN VOLUP VOLDN 
SCAN 0 1 2 
3 4 5 6 
7 8 9 POWER 

 
In general commands are issued in combination of "device action" the format follows the standard 
format used with HomeVoice for infrared controllers as follows. The Command editor has not 
been updated for the standard format for this controller so it will build commands separately. The 
commands will function the same in either case. The standard format for HomeVoice™ infrared 
commands are as specified above. 
 

IRR=AMP POWER 
IRR=TV VOLDN 

 
To provide the ability to address the infrared signal to a specified infrared port on the Houselinc 
the format of the IR commands was augmented slightly. The standard IR command header IRR is 
still valid and will send the IR signal to all 5 of the Houselinc emitter ports, the 5th port being the 
blast emitter on the front panel. Any Combination of emitter ports may be specified in the 
following manner. 
 
IR1=AMP POWER  the signal AMP POWER is sent to port 1. 
IR35=TV VOLDN  the signal TV VOLDN is sent to ports 3 and 5. 
IR1234=TUNER CHUP  the signal TUNER CHUP is sent to ports 1, 2, 3 and 4. 
IR12345=VCR REC 
   or 
IRR=VCR REC   the signal VCR REC is sent to all ports. 
 
 
Extended Infrared Commands. 
 
The Houselinc provides the capability to program infrared commands into the controller that are 
not listed in the table in the infrared section. In order to access these commands HomeVoice™ 
provide the extended infrared command. Please consult your Houselinc documentation for details 
on this capability. 
 
To transmit extended Infrared data the command is 
 
EIRR=446 Transmit function code 466. 
 
This command also supports the port-addressing scheme listed above in the IR command 
section. 
 
Firmware Revision 
 
To retrieve the revision data from the HouseLinc unit the command is: 
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revision 
 
HomeVoice™ will respond via the speech synthesizer with the current firmware revision for the 
Houslinc. 
 
Scenes 
 
To execute a SCENE command to command format is: 
 

SCENE=Movie Time   
 
Where "Movie Time" in this example is the scene defined in the Houslinc software. 
 

Note. HomeVoice is not case sensitive for commands. 
 

 

8 Appendix C: Home Automation, Inc. Manufactured 
Controllers 

  
The following command documentation is for using HomeVoice™ with Home Automation 
Controllers supporting the OMNI-LINK protocol specified by Home Automation Inc. The 
controllers manufactured by HAI are re-marketed under a variety of names including but not 
limited to HAI Omni and OmniPro. Home Systems Plus Aegis, AMP HMS 925 and HMS 1050. 
The command set documented here is for use in the “Keystroke” field of the HomeVoice™ 
command editor. Refer to your controller documentation for setup information referenced below. 
 
NOTE: In order to use these commands the users must have setup their passwords and user 
codes in the HomeVoice™ security menu. Otherwise HomeVoice™ will not be able to gain 
access to the controller. If there are three login failures the controller will lockout serial 
connections for 1 hour. Refer to the controller documentation to determine the proper passwords 
and user codes. 
 
In the command documentation that follows the following format is used. 
 
COMMAND=AREA or UNIT or ZONE:QUALIFIER 
 
For AREA, UNIT and ZONE the documentation will specify either 0-n or 1-n.  This refers to the 
range of AREA, UNIT or ZONE specified. 0-n refers to the range zero to the nth item where n is 
the largest available value for that item type. 1-n refers to the range one to the nth item where n is 
the largest available value for that item type. 
 
AREA 
 
The AREA command is for affecting all units in an AREA 
 
Format: AREA=AREA# COMMAND 
  AREA# = 0 - n  0 - specifies all areas 

COMMAND = ON or OFF 
Example: 
  AREA=3 OFF  Turn all units in area 3 off. 
 
ARM 
 
The ARM command is used for setting the desired security level for the security system. 
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Format: 
 

ARM=AREA:MODE 
 

AREA = 0 - n   where 0 specifies all areas 
 

MODE can be specified as either a numeric value or a text value as follows: 
  0 or disarm 
  1 or day 
  2 or night 
  3 or away 
  4 or vacation 
  5 or instant 
  6 or delayed 
Example: 
 
 ARM=0:AWAY (Arm all areas in away mode) 
 ARM=3:NIGHT (Arm area 3 in night mode) 
 
ASCII Commands 
 
The ability to send ASCII strings to the controller is only supported using the PRO-LINK protocol. 
Therefore the ASCII command will not work unless the module setting for the serial interface is 
set to PRO-LINK. 
 
Format: ASC=Text to be sent to controller 
 
All characters following the ASC= command will be sent to the controller as specified in the text 
string. 
 
Example: ASC=text string for trigger 
 
 The string “text string for trigger” is sent to the controller 
 
 
BUTTON 
 
The button command is used to execute macro buttons. Refer to your controller documentation 
for setting up button commands. 
 
Format: BUTTON=BUTTON#  
 

Where BUTTON# is the number of the button to execute, 1-n. 
 
Example: BUTTON=23 
 
Bypass Zone 
 
The bypass zone command is used to bypass a zone via the users security code. 
 
Format: BZ=ZONE#  Where ZONE# = 1-n 
 
Example: BZ=3 
 
  Bypass zone 3 with the current users security code. 
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CLEAR 
 
The CLEAR command is used for clearing messages. 
 
Format: CLEAR=MESSGE#:AREA# 
 
  Where Message number is 0 - n. 0 specifies all messages. 
 
If Message number is 0 then AREA# is required to specify the area for the messages to be 
cleared. Specifying an area number of zero specifies all areas. This is the default if it is not 
specified. 
 
COOL 
 
The COOL command is used for setting the thermostat HIGH or COOL set point.  
 
Format: COOL=TEMPERATURE  

Where TEMPERATURE is the desired temperature. 
 
Example: COOL=75 Set the cool set point to 75 degrees. 
 
Energy Saver 
 
The Energy Saver command is used for enabling and disabling the energy saving features of the 
controller.  
 
Format: ES=UNIT# COMMAND:DURATION 
 
 Where:  UNIT# = 1 - n 
   COMMAND = ON or OFF 
   DURATION is specified in the range as: 
    1 - 99 for 1 to 99 seconds 
    101-199 for 1 to 99 minutes 
    201-299 for 1 to 99 hours. 
 
Example: ES=3 ON:212  Set energy saver on unit 3 for 12 hours. 
 
FAN 
 
The FAN command is used for setting the fan mode on the thermostat. 
 
Format: FAN=MODE 
 
 Where MODE can be specified as a numeric digit or a text string 
  MODE = 1 or ON 
       0 or AUTO 
 
Example: FAN=AUTO  Set the fan mode to AUTO. 
 
HEAT 
 
The HEAT command is used for setting the thermostat LOW or HEAT set point. 
 
Format: HEAT =TEMPERATURE  

Where TEMPERATURE is the desired temperature. 
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Example: HEAT =65 Set the heat set point to 65 degrees. 
 
 
HOLD 
 
The HOLD command is used for setting the thermostat HOLD mode. 
 
Format: HOLD=MODE 
 
 Where MODE can be specified as a numeric digit or a text string 
  MODE = 0 or OFF 
       255 or HOLD 
 
LOG 
 
The LOG message is for logging the message specified. 
 
Format: LOG=MESSAGE# 
 
  Where MESSAGE# = 1 - n 
 
Example: LOG=5 Log message number 5 
 
MODE 
 
The MODE command is used for setting the thermostat system mode. 
 
Format: MODE=SETTING 
 
  Where SETTING can be specified as a numeric digit or a text string 
  SETTING = 0 or OFF 
             1 or HEAT 
    2 or COOL 
    3 or AUTO 
 
Example: MODE=AUTO (Set system mode to auto) 
 
PERCENT 
 
The PERCENT command is to be used for setting the unit lighting level to the percentage 
specified.  
 
Format: PERCENT=UNIT#:%SETTING 
 

Where UNIT# = 1 - n 
%SETTING = 0 - 100 

 
PHONE 
 
The PHONE command is used for calling numbers stored in the controller and playing messages 
stored in the controller. 
 
Format: PHONE=PHONE#INDEX:MESSAGE#INDEX 
 
  Where PHONE#INDEX is the index value for the phone number desired. 
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   MESSAGE#INDEX is the index for the message number desired. 
 
Example: PHONE=4:8 (Dial number at index 4 and play message at index 8) 
 
Restore All Area 
 
The RESTORE ALL AREA command is used to restore all zones in an area using the users 
security code. 
 
 Format: RAA=AREA# 
 
  Where AREA# is 0 - n. Area 0 specifies all areas. 
 
Example: RAA=0 Restore all zones in all areas. 
 
Request Auxiliary Status 
 
The Request Auxiliary Status command retrieves the status of an auxiliary device and verbally 
reports the information: The information returned is the Temperature, Relay Status, Heat Set 
Point, and Cool Set Point. 
 
Format: RAS=UNIT# 
 
  Where UNIT# is the unit status is being requested for. 
Example: RAS=6 Request status on Auxiliary device 6. 
 
Request System Information 
 
Request System Information is used to get information regarding the system. The information is 
returned verbally through the speech synthesizer. The information provided is the System Model, 
Version number, Phone number, RSI (Request System Information) 
 
Format: RSS 
 
Example: RSS 
 
Request Thermostat Status 
 
Request Thermostat Status is used for retrieving thermostat status information. The information is 
provided verbally through the voice synthesizer. The information provided is the Heat Set Point, 
Cool Set Point, System Mode, Fan Setting and Hold Status.  
 
Format: RTS=THERMOSTAT# 
 

Where THERMOSTAT# is the number of the thermostat. 
 

Example: RTS=1  Request status of thermostat 1. 
 
Request Unit Status 
 
Request Unit Status is used to retrieve status of a unit. The unit status is reported via voice 
synthesizer and reports the units last commanded state. Statuses of devices commanded outside 
of the controller are not reported correctly. The statuses returned is On, Off, or last Dim or Bright 
level command. 
 
Format: RUS=UNIT# 
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  Where UNIT# is the number of the unit status is requested for. 
 
Example: RUS=7 (Retrieve the status of unit 7) 
 
Request Zone Status 
 
Request Zone Status is used to retrieve the status of a zone. The information is presented 
verbally via the voice synthesizer. The information returned is the Current Condition, Latched 
Alarm Status and Arming Status. 
 
Format: RZS=ZONE# 
 
  Where ZONE# is the number of the zone status is requested for. (1 - n) 
 
Example: RZS=4  (Request Status of Zone 4) 
 
Restore Zone 
 
The Restore Zone Command is used to restore a zone using the user’s authorization code. 
 
Format: RZ=ZONE# 

Where ZONE# is the number of the zone status is requested for. (1 - n) 
 
Example: RZ=4 (Restore zone 4 using the current user’s authorization code.) 
 
SAY  
 
The SAY command is used to say a message. 
 
Format: SAY=MESSAGE# 
 
 Where: MESSAGE# is the number of message (1 - n). 
 
Example: SAY=5 (Say message number 5) 
 
SHOW 
 
The SHOW command is used to show messages. 
 
Format: SHOW=MESSAGE# 
 
 Where: MESSAGE# is the number of message (1 - n). 
 
Example: SHOW=3 (Show message number 3) 
 
Set Energy Cost 
 
The Set Energy Cost command is used to set energy cost modules. 
 
Format: SEC=COST 
 
  Where COST is a digit or text string specifying the unit cost. 
  COST = 0  or low 
     1  or mid 
     2  or high 
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     3  or critical 
 
TEMP 
 
The TEMP command is used to return the temperature from a thermostat. This is used when only 
the temperature is desired. Use Request Thermostat Status (RTS) when all information is 
desired. The temperature is returned via voice synthesizer. 
 
Format: TEMP=THERMOSTAT# 
 
Where THERMOSTAT# is the number of the thermostat to get the temperature from. 
 
Example: TEMP=2 Get the temperature from thermostat 2. 
 
TEMP_S 
 
The TEMP_S command is to get the temperature from a temperature sensor. This is used when 
only the temperature is desired. Use Request Auxiliary Status (RAS) when all information is 
desired. The temperature is returned via voice synthesizer. 
 
Format: TEMP_S=SENSOR# 
 
Where SENSOR# is the number of the auxiliary sensor to get the temperature from. 
 
Example: TEMP_S=4  Get the temperature from sensor 4. 
 
 
UNIT 
 
The UNIT command is used to change the status of a unit. 
 
Format: UNIT=UNIT# COMMAND: DURATION 
 
 Where:  UNIT# = 1 - n 
   COMMAND = ON, OFF, DIM, BRT 
   DURATION is specified in the range as: 
    1 - 99 for 1 to 99 seconds 
    101-199 for 1 to 99 minutes 
    201-299 for 1 to 99 hours. 
 
NOTE:  For the DIM and BRT commands the number of levels to be dimmed or brightened must 
be specified with the command. 
 
Example: UNIT=65 DIM=5:123 Dim unit 65 five levels for 23 seconds. 
  UNIT=4 OFF   Turn off unit 4. 
 
X10  
 
The X10 command is used for changing the status of X10 devices. This command is identical to 
the UNIT command in function. 
 
Format: X10=HOUSECODEUNITCODE COMMAND:DURATION 
 
Where HOUSECODE is the X10 units’ house code (A-P) 
 UNITCODE is the X10 units’ device code (1-16) 
 COMMAND = ON, OFF, DIM, BRT 
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 DURATION is specified in the range as: 
  1 - 99 for 1 to 99 seconds 
  101-199 for 1 to 99 minutes 
  201-299 for 1 to 99 hours. 
 
NOTE:  For the DIM and BRT commands the number of levels to be dimmed or brightened must 
be specified with the command. 
 
Example: X10=D2 DIM=5:123 Dim unit D2 five levels for 23 seconds. 
  X10=A4 OFF  Turn off unit A4. 
 
NOTE: There is not an ALL type of X10 command since the X10 house code does not map to an 
area number necessarily. Refer to AREA command for details. 
 
 

9 Appendix D. HomeVision Additions in Version 2.3 
 
In version 2.3 HomeVoice™ added the ability to communicate with HomeVision via Dynamic Data 
Exchange (DDE). This allows the HomeVision software to be active at the same time that 
HomeVoice™ is running. When operating in DDE mode Homevoice™ sends the commands to 
the HomeVision software which then sends the commands via the computer serial port to the 
HomeVision controller. 
 
Starting HomeVoice™ for DDE communication with HomeVision. 
 
From the HomeVoice™ window select the File menu and then Controller Setup > and then 
select Default Controller….You will be presented with the following dialog to change the 
controller. Select HomeVisionDDE from the controller list and then click on ‘OK’. 
 

 
 
You will receive the following error. 
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Click on ‘OK’ and HomeVoice™ will terminate. Start the HomeVision software and make sure 
DDE communication is enable in the HomeVision software. Consult your HomeVision 
documentation for details. Once the HomeVision software is up and running restart 
HomeVoice™. 
 
Macro 
 
HomeVoice™ also added support for HomeVision macros. To invoke a macro in HomeVision in 
the Keystroke field of the command enter: 
 
Macro = <Macro Name> Where the actual name of the macro, as saved in the 

HomeVision schedule is inserted for <Macro Name>. 
 
Responses to Macros in HomeVoice 
 
HomeVoice™ does not send the response until the HomeVision sends a completion 
acknowledgement to HomeVoice™. The HomeVision controller does not send the 
acknowledgement until the macro is completed. Depending on the length of the macro the 
response could be delayed for some time. During this time the HomeVision can not accept any 
new commands until macro completion. This means there is a possibility that HomeVoice™ 
commands may be issued but not processed by the controller. 


